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Introduction to Training Tasks

Think about photography. Professional photographers take splendid pictures. They work
creatively with multiple cameras and lenses, tinkering endlessly with characteristics of film and F-
stops and shutter speed and the angle and intensity of light. Most people, however, sidestep these
complexities and rely instead on cameras with pre-programmed settings and restricted capacities.
Avid amateur photographers seek to add the complexities, hoping to learn techniques to make
their pictures more powerful.

This analogy has value for those interested in using geographic information systems (GIS) in
schools and libraries. Not satisfied with the restrictions placed by other computer mapping
packages, GIS users seek to craft their own maps. But, just as the budding photographer adds
knowledge and skill only through study and practice, the budding GIS user develops
understanding and technique only through exploration and exercise. ArcVoyager Special Edition
has made some of this easier, but users still need to know how to manipulate the software and
why to do certain activities using specific steps.

The accompanying series of tasks will help novice ArcVoyager Special Edition users learn the
basic steps. Each task is designed as a stand-alone item, though some use a previously completed
task as a starting point. They are listed on the Contents page in the order that will probably be the
easiest for the widest range of users.

The tasks are not powerful exercises in geography nor complex cartographic presentations. They
are “beginning exercises” which teach new users how to work with generic “out of the box”
ArcVoyager Special Edition, in order to meet typical needs. Each task relies on basic skills. It is
important to get comfortable with the fundamentals of ArcVoyager Special Edition so that these
multi-step operations become second nature. Once this has been accomplished, a user can spend
time and energy focused on the analytical powers of GIS, rather than getting bogged down in
which button to click.

Each task is presented in terms of a problem solving sequence. There is an overall title defining
the general goal for each task. Meeting the goal involves completing a series of operations. Each
operation is presented in the form of “Here is generally what I need to do,” then followed with
one or more specific steps detailing the sequence and focus of the step, and how these steps
would be accomplished on Macintosh or Windows-based computers.

With a fast computer (see specifications at http://www.esri.com/base/markets/k-12/bundle.html)
and careful attention to detail, most of these tasks can be completed in just a few minutes. By
attempting these tasks, users can gain practical experience in creating maps for various purposes
at a variety of scales. Users completing these tasks should have the background needed to start
exploring on their own, like the amateur photographer venturing out into the world.
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ArcVoyager Special Edition Task W1
Create a black and white outline map of the world

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a place to make the map.”
1. Create a place for the map
to be displayed. (Maps are
shown in “View” windows.)

Having just started ArcVoyager Special Edition, use the help
file to engage the "TURN ME LOOSE/ Creating New Worlds:
Startup Project." It opens with "View1" as a map space.

“I need to get some data to map.”
2. Indicate that you want to
add a "Theme" (a mapable
layer of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory
DATA\GEO\WORLD.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder
DATA\GEO\WORLD.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom of the Add Theme window, click and hold on
the Data Source Type and choose Feature Data Source.

“I need to choose the right piece of data from the many available.”
5. Select the proper data
source. (The correct item
here will insert country
boundaries.)

(Win) In the left column,
click the item called
country.shp, then click OK.
The theme will be added to
the top of the Table of
Contents window in the
View.

(Mac) In the right-hand
column, click the item called
country.shp, then click Add.
The theme will be added to
the top of the Table of
Contents window in the
View.
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“I need to see what the stuff I added looks like.”
6. Display the map. (Themes
do not display until they are
turned on.)

In the Table of Contents, click the little checkbox at the left
of the theme Country.shp, making a black check mark
appear.

“I need to add another layer to the map.”
7. Add a background layer for
the countries.

Click the Add Theme button again.

“I need to go find the data.”
8. Navigate to the proper
directory.

You should already be in the correct directory, which is
DATA\GEO\WORLD.

“I need to make sure I’m getting the right type of data.”
9. Ensure that the data type
sought is the correct format.

You should already have the right kind of data identified. In
the bottom of the Add Theme window, the Data Source
Type should show Feature Data Source.

"I need to choose the right piece of data from the many available."
10. Select the proper data
source. (This will create areas
of 30 degrees longitude by 30
degrees latitude in the map.)

(Win) In the left-hand
column, click the item called
world30.shp, then click OK.
The theme will be added to
the top of the Table of
Contents window in the
View.

(Mac) In the right-hand
column, click the item called
world30.shp, then click Add.
The theme will be added to
the top of the Table of
Contents window in the
View.

“I need to see what the stuff I added looks like.”
11. Display the theme. (Turn
on the newly added feature.)

In the Table of Contents, click the little checkbox at the left
of World30.shp, making a black check mark appear.

“I need to shuffle the layers into proper display order.”
12. Adjust the order of theme
display so the layers are
properly visible. (ArcView
draws themes according to
their order in the Table of
Contents.)

In the Table of Contents, click and hold directly on the name
World30.shp and drag the theme down below the theme
Country.shp, then let go. The map will re-draw.

“I need to adjust the ocean color.”
13. Adjust the ocean symbol.
Start by calling up the Legend
Editor. (This process will
provide many choices, thus
entail many steps.)

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme World30.shp.
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14. Adjust the ocean symbol.
Continue by calling up the
symbol palette. (The symbol
palette allows you to define
many different elements of
symbols.)

In the Legend Editor window, double click the color box
shown for the ocean layer (bottom part of window, first box,
left-hand column). The Symbol Palette will appear, with the
Fill Palette option visible.

15. Adjust the ocean symbol.
Continue by specifying the
color palette window.

In the Fill Palette window, in the first row of icons, click the
paintbrush to bring up the Color Palette window.

16. Adjust the ocean symbol.
Continue by selecting a color.

In the choices of colors, click on the lightest gray box. Close
the Color Palette window.

17. Adjust the ocean symbol.
Finish by applying the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to adjust the countries color.”
18. Adjust the countries
symbol. Start by calling up
the Legend Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Country.shp.

19. Adjust the countries
symbol. Continue by calling
up the symbol palette.

In the Legend Editor window, double click the color bar
shown for the countries layer (bottom part of window, first
box, left-hand column). The Symbol Palette will appear, with
the Fill Palette option visible.

20. Adjust the countries
symbol. Continue by
specifying the color palette
window.

In the first row of icons, click the paintbrush to bring up the
Color Palette.

21. Adjust the countries
symbol. Continue by selecting
a color.

In the choices of colors, click on the white box (top row,
second column). Close the Color Palette window.

22. Adjust the countries
symbol. Finish by applying the
change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“It’s all done!”
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ArcVoyager Special Edition Task W2
Create a choropleth map of the world

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task W1.

“I need to adjust the ocean color.”
2. Adjust the ocean symbol.
Start by calling up the Legend
Editor. (This process will
provide many choices, thus
entail many steps.)

In the Table of Contents, doubleclick directly on the name
itself (not on the checkbox) for the theme World30.shp.

3. Adjust the ocean symbol.
Call up the symbol palette.
(The symbol palette allows
you to define many different
elements of symbols.)

In the Legend Editor window, double click the color bar
shown for the ocean layer (bottom part of window, first box,
left-hand column). The Symbol Palette will appear, with the
Fill Palette option visible. Move the Fill Palette window to
the side of the Legend Editor window.

4. Adjust the ocean symbol.
Specify the color palette
window.

In the Fill Palette window, in the first row of icons, click the
paintbrush to bring up the Color Palette.

5. Adjust the ocean symbol.
Specify foreground.

In the pull-down menu beside Color:, select Foreground.

6. Adjust the ocean symbol.
Select foreground color.

In the color boxes, choose royal blue (fourth row, third
column).

7. Adjust the ocean symbol.
Specify outline.

In the pull-down menu beside Color:, select Outline.

8. Adjust the ocean symbol.
Select outline color.

In the color boxes, choose cyan (fifth row, third column).
Close the Color Palette window.

9. Adjust the ocean symbol.
Apply the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.
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“I need to see if a layer contains data I can map.”
10. Select a theme, to focus
the computer’s attention on
that layer. (This is now the
“active” theme.)

In the Table of Contents, click one time directly on the name
Country.shp. The theme will look “raised” within the Table
of Contents.

11. Bring up the active
theme’s data table.

Click one time on the Open Theme Table button (looks like a
page with a series of columns and rows).

12. Explore the table. (This
table contains the information
about the features. It is
formally called a Feature
Attribute Table.)

At the bottom of the table document Attributes of
Country.shp, click on the right scroll arrow several times to
explore all the columns of available data. Leave the table
scrolled all the way to the right.

“I need to add to the feature table some data to map.”
13. Indicate you want to add
a data table.

Click the Add Table button.

“I need to find the data to add.”
14. Navigate to the proper
directory.

Navigate to the directory DATA\TABLE\WORLD.

“I need to identify the correct type of data.”
15. Choose the proper type of
file.

In the bottom of the window, click on the List Files of Type:
pull-down menu. Choose dBASE (*.dbf).

“I need to add the correct data table.”
16. Choose the proper table. In the left-hand column file picker, double click the item

demog.dbf.
“I need to join the new data table to the existing feature table.”

17. Select the matching field
in the source table.

In the table demog.dbf, click one time on the field name
Fips_code. The field name will appear darkened. Click and
hold on the menu bar for this table and slide the table off to the
side, so the other windows are visible.

18. Select the window for the
target table

Click on the Window menu and select Attributes of
Country.shp

19. Select the matching field
in the target table.

In the table Attributes of Country.shp, click one time on the
field name Fips_code. The field name will appear darkened.

20. Join the source data to the
target feature table.

Click the Join Table button (looks like two tables kissing).
The data from the source table will be appended to the
appropriate records in the target table. The source table will
disappear. Close the table Attributes of Country.shp.
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“I need to edit the legend for the newly joined theme.”
21. Adjust the country
symbol. Start by calling up
the Legend Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Country.shp.

22. Adjust the country
symbol. Continue by defining
a mapping method.

In the second pull-down menu, called Legend type, choose
Graduated color.

23. Adjust the country
symbol. Continue by defining
the mapped theme.

In the Legend Editor window, click the pull-down menu for
Classification Field: and scroll down the list to select
Gnp_cap. The computer will automatically divide the data
into five categories, with breaks where they fit best.

24. Adjust the country
symbol. Continue by
excluding "no data" items.

Near the bottom of the Legend Editor, above the Color
Ramps choices, click the slashed Zero. Set the field as
Gnp_cap, type -99 in the Null value bar, and click the
Display no data class button. Click OK.

25. Adjust the country
symbol. Change the
classification scheme.

Click the Classify... button. In the Classification window,
change the Type: to Quantile, then change Number of
Classes: to 4. Change the Round values at: to "ddd". Click
OK. The computer will re-divide the data.

26. Adjust the country
symbol. Set the color scheme.

Click on the Color Ramps: button and choose Green
monochromatic. Then click Apply. Close the Legend Editor
window. The map will re-draw.

27. Modify the theme name in
the Table of Contents.

With Country.shp still selected (looks “elevated”) in the
Table of Contents, click on the Theme menu item and
choose Properties... to bring up the Theme Properties
window.

28. Modify the theme name.
Specify new name. Choose to
display the field being
mapped.

In the top row, next to Theme Name:, erase “Country.shp”
and type “Countries”. In the box at the top right, next to Use
Suffix, click the box to place an “x” within it. Click OK.

“I need to change the map projection.”
29. Indicate the need to
change the characteristics of
the View.

From the View menu, click Change Map Projection… and
select Robinson.

“It’s all done!”
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ArcVoyager Special Edition Task W3
Create a choropleth map of the world with many layers

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task W2.

“I need to get some data to map.”
2. Indicate that you want to
add a theme (a mapable layer
of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find more data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory
DATA\GEO\WORLD.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder
DATA\GEO\WORLD.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom left of the Add Theme window, click and hold
on the Data Source Type and choose Feature Data Source.
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“I need to choose the right pieces of data from the many available.”
5. Select multiple sources.
(The correct items here will
add lakes, rivers, and cities.)

(Win) In the left-hand
column, click one time on the
icon for w_lakes.shp. Hold
down the Shift key on the
keyboard to permit multiple
selection. In the left-hand
column, click one time on the
icon for w_rivers.shp, and
one time on w_cities.shp,
highlighting all three items.
Click OK.

(Mac) In the right-hand
column, click one time on the
icon for w_lakes.shp. Hold
down the Command key on
the keyboard to permit
multiple selection. In the left-
hand column, click one time
on the icon for w_rivers.shp,
and one time on
w_cities.shp, highlighting all
three items. Click Add.

“I need to see what the stuff I added looks like.”
6. Display the map. (Turn on
the newly added features.)

In the Table of Contents, click the little checkboxes at the left
of the themes W_lakes.shp, W_rivers.shp, and
W_cities.shp, making a black check mark appear for each.

“I need to adjust the color of the lakes.”
7. Adjust the lakes symbol.
Start by calling up the Legend
Editor. (This process will
provide many choices, thus
entail many steps.)

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme W_lakes.shp.

8. Adjust the lakes symbol.
Continue by calling up the
symbol palette. (The symbol
palette allows you to define
many different elements of
symbols.)

Double click the color bar shown for the lakes layer (bottom
half of window, first box, left-hand column). The Symbol
Palette will appear, with the Fill Palette option visible. Move
the Fill Palette window to the side of the Legend Editor
window.

9. Adjust the lakes symbol.
Continue by specifying the
color palette window.

In the first row of icons in the Fill Palette window, click the
paintbrush to bring up the Color Palette.

10. Adjust the lakes symbol.
Continue by specifying
foreground.

In the pull-down menu beside Color:, select Foreground.

11. Adjust the lakes symbol.
Continue by selecting
foreground color.

In the color boxes, choose royal blue (fourth row, third
column).

12. Adjust the lakes symbol.
Continue by specifying
outline.

In the pull-down menu beside Color:, select Outline.

13. Adjust the lakes symbol.
Continue by selecting no
outline.

In the color boxes, choose empty (top row, left column).
Close the Color Palette window.
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14. Adjust the lakes symbol.
Finish by applying the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to adjust the color of the rivers.”
15. Adjust the river symbol.
Start by calling up the Legend
Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme W_rivers.shp.

16. Adjust the river symbol.
Continue by calling up the
symbol palette.

Double click the color zigzag shown for the river layer
(bottom half of window, first box, left-hand column). The
Symbol Palette will appear, with the Pen Palette option
visible. Move the Pen Palette window to the side of the
Legend Editor window.

17. Adjust the river symbol.
Continue by specifying the
color palette window.

In the first row of icons in the Pen Palette window, click the
paintbrush to bring up the Color Palette.

18. Adjust the river symbol.
Continue by specifying
foreground.

In the pull-down menu beside Color, select Foreground.

19. Adjust the river symbol.
Continue by selecting
foreground color.

In the color boxes, choose royal blue (fourth row, third
column). Close the Color Palette window.

20. Adjust the river symbol.
Finish by applying the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to adjust the color of the cities.”
21. Adjust the cities symbol.
Start by calling up the Legend
Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme W_cities.shp.

22. Adjust the cities symbol.
Continue by calling up the
symbol palette.

Double click the color dot shown for the cities layer (bottom
half of window, first box, left-hand column). The Symbol
Palette will appear, with the Marker Palette option visible.
Move the Marker Palette window to the side of the Legend
Editor window.

23. Adjust the cities symbol.
Continue by specifying the
symbol size.

Below the icons in the Marker Palette window, click the
Size: menu’s pull-down arrow. Select size 4.

24. Adjust the cities symbol.
Continue by specifying the
color palette window.

In the first row of icons in the Marker Palette window, click
the paintbrush to bring up the Color Palette.

25. Adjust the cities symbol.
Continue by specifying
foreground.

In the pull-down menu beside Color:, select Foreground.

26. Adjust the cities symbol.
Continue by selecting
foreground color.

In the color boxes, choose bright red (second row, third
column). Close the Color Palette window. Click Apply. Close
the Legend Editor window. The map will re-draw.
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“I need to zoom in to focus on one area.”
27. Select the “zoom in” tool. From the tool bar, choose the Zoom In tool (magnifying glass

with a plus sign).
28. Zoom in to a defined area. Using the mouse, click and hold with the mouse in the mid-

Atlantic, north and west of Africa. Keep holding the mouse
button as you move the mouse south and east, defining a box
around Africa. (If you are not happy with the result, do
Step29. If you are happy with the result, skip to Step30.)

29. Zoom all the way back
out before trying again.

Click the Zoom To Full Extent button (looks like an arrow
pushing down on three blank sheets of paper). Then return to
Step28.

“I need to see the table of information about the countries.”
30. Select the theme to
explore.

Click one time on the theme Countries in the Table of
Contents. The theme will appear slightly elevated in the
column.

31. Bring up the table. Click on the Table button (looks like a document of rows and
columns of information).

32. Turn off some of the
unneeded fields.

From the menu bar, choose Table\Properties.... The bottom
half of the window includes a listing of the available items in
the table. Click the black checkmarks to toggle between visible
and invisible. Make the first six fields invisible. The visible
fields should start again with the second Abbrevname, and
continue. Click OK and return to see the changes in the table.
Close the table.

“I need to select a few countries for closer investigation.”
33. Select some geographic
features from the view.

The theme Country should still be selected (looks “raised”).
Click and hold on the Select Features tool and choose the
box. Using the tool in a fashion similar to the Zoom In tool,
click and drag a low but wide box through portions of the five
northernmost countries in Africa. The map will re-draw, with
the five countries displaying in yellow.

34. Bring up the table. Click on the Table button again.
35. Make the selected
countries’ information visible.

Click the Promote button (right of the hammer, looks like two
lines merging into an upward pointing arrow). Scroll right in
the table to explore the information.

36. Unselect one of the set. (Win) In the table, hold down
the SHIFT key on the
keyboard and click one time
on one of the selected
countries. Then let go of the
SHIFT key. The country will
return to its original color.

(Mac) In the table, hold
down the COMMAND key
on the keyboard and click one
time on one of the selected
countries. Then let go of the
COMMAND key. The
country will return to its
original color.
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37. Close the table. Close the table. Notice that now only four countries are listed
as selected.

“I need to zoom to the selected region.”
38. Zoom to the scale of the
selected items.

Click on the Zoom to Selected button (looks like a diagonal
arrow pointing to a small set of boxes). The map will re-draw,
zoomed in to the scale of the selected countries.

“I need to unselect all countries.”
39. Unselect all records. Click on the Clear Selected Features button (looks like a

blank 3-ring loose leaf note page). The countries will re-draw
in their original color.

“I need to label some items.”
40. Select the label tool. Click the Label tool (looks like a luggage tag, just left of the

text tool).
41. Label desired countries One by one, click one time in the center of the four countries

which had been selected. The country name will appear. The
little boxes around the names indicate these are movable and
scalable graphic elements.

“I need to move some labels.”
42. Select the graphic
selection tool.

Click the graphic selection tool (second tool, looks like a
simple arrow).

43. Move the graphics. One by one, click and hold on the center of each graphic
element (do not hold onto the handles themselves, but between
the handles) and move the name to a suitable spot. It is best to
just click and select the graphic first, then click and drag it in a
second action. Unselect graphics by clicking in the view
outside the graphics.

“It’s all done!”
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ArcVoyager Special Edition Task U1
Create a black and white outline map of the US

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a place to make the map.”
1. Create a place for the map
to be displayed. (Maps are
shown in “View” windows.)

Having just started ArcVoyager Special Edition, use the help
file to engage the "TURN ME LOOSE/ Creating New Worlds:
Startup Project." It opens with "View1" as a map space.

“I need to get some data to map.”
2. Indicate that you want to
add a "Theme" (a mapable
layer of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory DATA\GEO\US.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom of the Add Theme window, click and hold on
the Data Source Type and choose Feature Data Source.

“I need to choose the right piece of data from the many available.”
5. Select the proper data
source. (The correct item
here will insert US states.)

(Win) In the left column,
click the item called
us_state.shp, then click OK.
The theme will be added to
the top of the Table of
Contents window in the
View.

(Mac) In the right-hand
column, click the item called
us_state.shp, then click Add.
The theme will be added to
the top of the Table of
Contents window in the
View.
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“I need to see what the stuff I added looks like.”
6. Display the map. (Themes
do not display until they are
turned on.)

In the Table of Contents, click the little checkbox at the left
of the theme Us_state.shp, making a black check mark
appear.

“I need to add another layer to the map.”
7. Add a context layer for the
countries.

Click the Add Theme button again.

“I need to go find the data.”
8. Navigate to the proper
directory.

Navigate to the correct directory, which is
DATA\GEO\NAMERICA.

“I need to make sure I’m getting the right type of data.”
9. Ensure that the data type
sought is the correct format.

You should already have the right kind of data identified. In
the bottom of the Add Theme window, the Data Source
Type should show Feature Data Source.

"I need to choose the right piece of data from the many available."
10. Select the proper data
source. (This will create the
provinces of Canada.)

(Win) In the left-hand
column, click the item called
canada.shp, then click OK.
The theme will be added to
the top of the Table of
Contents window in the
View.

(Mac) In the right-hand
column, click the item called
canada.shp, then click Add.
The theme will be added to
the top of the Table of
Contents window in the
View.

“I need to see what the stuff I added looks like.”
11. Display the theme. (Turn
on the newly added feature.)

In the Table of Contents, click the little checkbox at the left
of the theme Canada.shp, making a black check mark appear.

“I need to zoom out to see everything.”
12. Adjust the scale of display
so the themes are properly
visible.

Click the Zoom to All Themes button (looks like an arrow
pushing down on three blank layers). The map will re-draw.

“I need to adjust the province color.”
13. Adjust the province
symbol. Start by calling up
the Legend Editor. (This
process will provide many
choices, thus entail many
steps.)

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Canada.shp.
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14. Adjust the province
symbol. Continue by calling
up the symbol palette. (The
symbol palette allows you to
define many different
elements of symbols.)

In the Legend Editor window, double click the color box
shown for the province layer (bottom part of window, first
box, left-hand column). The Symbol Palette will appear, with
the Fill Palette option visible.

15. Adjust the province
symbol. Continue by
specifying the color palette
window.

In the Fill Palette window, in the first row of icons, click the
paintbrush to bring up the Color Palette window.

16. Adjust the province
symbol. Set the color

In the choices of colors, click on the top row, fourth column,
which is light grey. Close the Color Palette window.

17. Adjust the province
symbol. Finish by applying the
change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to adjust the states color.”
18. Adjust the states symbol.
Start by calling up the Legend
Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme States.shp.

19. Adjust the states symbol.
Continue by calling up the
symbol palette.

In the Legend Editor window, double click the color bar
shown for the states layer (bottom part of window, first box,
left-hand column). The Symbol Palette will appear, with the
Fill Palette option visible.

20. Adjust the states symbol.
Continue by specifying the
color palette window.

In the first row of icons, click the paintbrush to bring up the
Color Palette.

21. Adjust the states symbol.
Continue by selecting white.

In the choices of colors, click on the top row, second column,
which is white. Close the Color Palette window.

22. Adjust the states symbol.
Finish by applying the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to rename the display.”
23. Open the View Properties
and change the View name

Click the menu item for View\Properties. In the View
Properties window, inside the line for Name, erase “View 1”
and type “Outline”. Click OK.

“It’s all done!”
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ArcVoyager Special Edition Task U2
Create a choropleth map of the US

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task U1.

“I need to see if a layer contains data I can map.”
2. Select a theme, to focus
the computer’s attention on
that layer. (This is now the
“active” theme.)

In the Table of Contents, click one time directly on the name
Us_state.shp. The theme will look “raised” within the Table
of Contents.

4. Bring up the active theme’s
data table.

Click one time on the Open Theme Table button (looks like a
page with a series of columns and rows).

5. Explore the table. (This
table contains the information
about the features. It is
formally called a Feature
Attribute Table.)

At the bottom of the table document Attributes of
Us_state.shp, click on the right scroll arrow to explore all the
columns of available data.

“I need to add to the feature table some data to map.”
6. Indicate you want to add a
data table.

Click the Add Table button.

“I need to find the data to add.”
7. Navigate to the proper
directory.

Navigate to the directory DATA\TABLE\US.

“I need to identify the correct type of data.”
8. Choose the proper type of
file.

In the bottom of the window, click on the List Files of Type:
pull-down menu. Choose dBASE (*.dbf).

“I need to add the correct data table.”
9. Choose the proper table. In the left-hand column file picker, double click the item

st_data.dbf.
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“I need to join the new data table to the existing feature table.”
10. Select the matching field
in the source table.

In the table st_data.dbf, click one time on the field name
State_fips. The field name will appear darkened. Click and
hold on the menu bar for this table and slide the table off to the
side, so the other windows are visible.

11. Select the window for the
target table.

Click on the Window menu and select Attributes of
Us_state.shp

12. Select the matching field
in the target table.

In the table Attributes of Us_state.shp, click one time on the
field name State_fips. The field name will appear darkened.

13. Join the source data to the
target feature table.

Click the Join Table button (looks like two tables kissing).
The data from the source table will be appended to the
appropriate records in the target table. The source table will
disappear. Close the table Attributes of Us_state.shp.

“I need to edit the legend for the newly joined theme.”
14. Adjust the states symbol.
Start by calling up the Legend
Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Us_state.shp. This
will bring up the Legend Editor window.

15. Adjust the states symbol.
Continue by defining a
mapping method.

In the second pull-down menu, called Legend type, choose
Graduated color.

16. Adjust the states symbol.
Continue by defining the
mapped theme.

In the Legend Editor window, click the pull-down menu for
Classification Field: and scroll down the list to select
P_65_up. The computer will automatically divide the data into
five categories, with breaks where they fit best.

17. Adjust the states symbol.
Change the classification
scheme.

Click the Classify... button. In the Classification window,
change the Type: to Quantile, then change Number of
Classes: to 4. Leave the Round values at: as d.ddd. Click
OK. The computer will re-divide the data.

18. Adjust the states symbol.
Set the color scheme.

Click on the Color Ramps: button and choose Purple
monochromatic. Then click Apply. Close the Legend Editor
window. The map will re-draw.

19. Modify the theme name in
the Table of Contents.

With Us_state.shp still selected (looks “elevated”) in the
Table of Contents, click on the Theme menu item and
choose Properties... to bring up the Theme Properties
window.

20. Modify the theme name.
Specify new name. Choose to
display the field being
mapped.

In the top row, next to Theme Name:, change “Us_state.shp”
to just “States”. In the box at the top right, next to Use Suffix,
click the box to place an “x” within it. Click OK.

“I need to change the map projection.”
21. Indicate the need to
change the characteristics of
the View.

From the View menu, click Properties.... In the View
Properties window, click the button for Projection....
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22. Choose the desired
projection.

Click the Category: pull-down menu to select “Projections of
the US.” Click the Type: pull-down menu to select “Albers
Equal Area (North America).” Click OK.

23. Change the View name Back in the View Properties window, inside the line for
Name:, erase “Outline” and type “Percent Age 65 and Up”.
Click OK.

24. Change the map extent. Back in the View window, click the Zoom to Full Extent
button.

“It’s all done!”
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ArcVoyager Special Edition Task U3
Create a choropleth map of the 48 states by counties

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task U2.

“I need to get some data to map.”
2. Indicate that you want to
add a theme (a mapable layer
of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find more data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory DATA\GEO\US.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom left of the Add Theme window, click and hold
on the Data Source Type and choose Feature Data Source.

“I need to choose the right pieces of data from the many available.”
5. Select the proper data
source (The correct items
here will add counties.).

(Win) In the left-hand
column, double-click the item
us_cnty.shp.

(Mac) In the right-hand
column, double-click the item
us_cnty.shp

“I need to see what the stuff I added looks like.”
6. Display the map. (Turn on
the newly added feature.)

In the Table of Contents, click the little checkbox at the left of
the theme Us_cnty.shp, making a black check mark appear.
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“I need to see if a layer contains data I can map.”
7. Select a theme, to focus
the computer’s attention on
that layer. (This is now the
“selected” or “active”
theme.)

In the Table of Contents, click one time directly on the name
Us_cnty.shp. The theme will look “raised” within the Table of
Contents

8. Bring up the active
theme’s data table.

Click one time on the Table button (looks like a page with a
series of columns and rows).

9. Explore the table. (This
table contains the
information about the
features. It is formally called
a Feature Attribute Table.)

At the bottom of the table document Attributes of
Us_cnty.shp, click on the right scroll arrow to explore all the
columns of available data.

“I need to add to the feature table some data to map.”
10. Indicate you want to add
a data table.

Click the Add Table button.

“I need to find the data to add.”
11. Navigate to the proper
directory.

Navigate to the correct directory, which is DATA\TABLE\US

“I need to identify the correct type of data.”
12. Choose the proper type
of file.

In the bottom of the window, click on the Show Files of Type:
pull-down menu. Choose dBASE (*.dbf).

“I need to add the correct data table.”
13. Choose the proper table. In the left-hand column file picker, double click the item

county.dbf.
“I need to join the new data table to the existing feature table.”

14. Select the matching field
in the source table.

In the table county.dbf, click one time on the field name Fips.
(Make sure the column shows 5 characters per cell.) The field
name will appear darkened. Click and hold on the menu bar for
this table and slide the table off to the side, so the other
windows are visible.

15. Navigate to the target
table.

From the Window menu, choose Attributes of Us_cnty.shp.

16. Select the matching field
in the target table.

In the table Attributes of Us_cnty.shp, click one time on the
field name Fips. (Make sure the column shows 5 characters per
cell.) The field name will appear darkened.

17. Join the source data to
the target feature table.

Click the Join Table button (looks like two tables kissing).
The data from the source table will be appended to the
appropriate records in the target table. The source table will
disappear. Close the table Attributes of Us_cnty.shp.



ArcVoyager Special Edition Task U3, page   3
Copyright © 1998, Environmental Systems Research Institute, Inc.

“I need to edit the legend for the newly joined theme.”
18. Adjust the county
symbol. Start by calling up
the Legend Editor.

In the view’s Table of Contents, double click directly on the
name itself (not on the checkbox) for the theme Us_cnty.shp.
This will bring up the Legend Editor window.

19. Adjust the county
symbol. Define the map style.

In the Legend Editor window, click the pull-down menu for
Legend type: and choose Graduated color.

20. Adjust the county
symbol. Define the mapped
field.

In the Legend Editor window, click the pull-down menu for
Classification field: and scroll down the list to select
Age_65_up. The computer will automatically divide the data
into five categories.

21. Adjust the county
symbol. Change the
classification scheme.

Click the Classify... button. In the Classification window,
change the Type to Equal Interval, change Number of
Classes to 4, and leave Round values at as d.ddd. Click OK.
The computer will re-divide the data, into four classes that
cover the same size range of numbers.

22. Adjust the county
symbol. Change from
absolute numbers to decimal
portion.

From the Normalize by: pull-down menu, choose Pop_1990.

23. Adjust the county
symbol. Omit the outline
around counties.

One by one, double click the color boxes. When the symbol
palette appears, use the Outline pull-down menu at the bottom
to select None. Close the Symbol palette window. Click
Apply. Close the Legend editor window.

“I need to adjust the color of the states.”
24. Adjust the states symbol.
Start by calling up the
Legend Editor. (This process
will provide many choices,
thus entail many steps.)

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme States.shp.

25. Adjust the state symbol.
Specify no field to map.

Click the Legend type: pull-down menu and choose "Single
symbol".

26. Adjust the states symbol.
Continue by calling up the
symbol palette.

Double click the color bar shown for the states layer (bottom
half of window, first box, left-hand column). The Symbol
Palette will appear, with the Fill Palette option visible. Move
the Fill Palette window to the side of the Legend Editor
window.

27. Adjust the states symbol.
Continue by specifying the
color palette window.

In the first row of icons in the Fill Palette window, click the
paintbrush to bring up the Color Palette.

28. Adjust the states symbol.
Continue by specifying
foreground.

In the pull-down menu beside Color:, select Foreground.



ArcVoyager Special Edition Task U3, page   4
Copyright © 1998, Environmental Systems Research Institute, Inc.

29. Adjust the states symbol.
Continue by selecting
foreground color.

In the color boxes, click any color, then choose "empty" (top
left box, with an "X" in it). Close the Color palette window.
Click Apply. Close the Legend editor window. The map will
re-draw.

“I need to change the order of the layers.”
30. Rearrange the order in
which the themes display.

In the Table of Contents, click and hold on the name States
and drag the theme upward to be above Us_cnty.shp.

“It’s all done!”
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ArcVoyager Special Edition Task S1
Create a black and white county outline map of a state

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a place to make the map.”
1. Create a place for the map
to be displayed. (Maps are
shown in “View” windows.)

Having just started ArcVoyager Special Edition, use the help
file to engage the "TURN ME LOOSE/ Creating New Worlds:
Startup Project." It opens with "View1" as a map space.

“I need to get some data to map.”
2. Indicate that you want to
add a "Theme" (a mapable
layer of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory DATA\GEO\US.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom of the Add Theme window, click and hold on
the Data Source Type and choose Feature Data Source.

“I need to choose the right piece of data from the many available.”
5. Select the proper data
source. (The correct item
here will insert counties.)

(Win) In the left column,
click the item called
us_cnty.shp, then click OK.
The theme will be added to
the top of the Table of
Contents window in the
View.

(Mac) In the right column,
click the item called
us_cnty.shp, then click Add.
The theme will be added to
the top of the Table of
Contents window in the
View.
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“I need to see what the stuff I added looks like.”
6. Display the map. (Themes
do not display until they are
turned on.)

In the Table of Contents, click the little checkbox at the left
of the theme Us_cnty.shp, making a black check mark appear.
With over 3100 counties, it may take a while for them to
draw.

“I need to restrict the features being displayed.”
7. Modify the theme
properties. Call up the theme
properties window.

From the Theme menu, choose Properties...

8. Modify the theme
properties. Make a definition.

The left column of the Theme Properties window contains
several large buttons. Highlight Definition, then click the
Query Builder button (hammer with question mark).

9. Modify the theme
properties. Construct the
definition.

In the Query Builder window, in the left-hand column
showing Fields, double click [State_name]. In the central
column, click the equals sign ("="). Scroll down the right-
hand column, find “Michigan”, and double click it. (Using the
mouse to select items, rather than typing, helps ensure proper
syntax.)

10. Modify the theme
properties. Check the
definition.

The box in the bottom of the Query Builder window should
read ([State_name] = “Michigan”). Note the presence and
positions of parentheses, brackets, and quote marks. These
need to be exact. If the statements don’t match, close the
Query Builder and return to Step9. When everything is
correct, click OK.

11. Modify the theme
properties. Apply the
definition.

Back in the Theme Properties window, click OK. The
computer will think for a second, sorting counties, and then
close the Theme Properties window. The map will re-draw.

“I need to zoom in to see everything.”
12. Adjust the scale of display
so the theme is properly
visible.

Click the Zoom to Active Themes button (looks like an arrow
pushing down on three layers arranged as light-dark-light).
The map will re-draw.

“I need to adjust the county color.”
13. Adjust the county symbol.
Call up the Legend Editor.
(This process will provide
many choices, thus entail
many steps.)

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Us_cnty.shp.
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14. Adjust the county symbol.
Call up the symbol palette.
(The symbol palette allows
you to define many different
elements of symbols.)

In the Legend Editor window, double click the color box
shown for the county layer (bottom part of window, first box,
left-hand column). The Symbol Palette will appear, with the
Fill Palette option visible.

15. Adjust the county symbol.
Specify the color palette
window.

In the Fill Palette window, in the first row of icons, click the
paintbrush to bring up the Color Palette window.

16. Adjust the county symbol.
Set the color.

In the choices of colors, click on the top row, second column,
which is white. Close the Color Palette window.

17. Adjust the county symbol.
Apply the change.

In the Legend Editor, click Apply. Close the Legend Editor
window. The map will re-draw.

“I need to change the map projection.”
18. Indicate the need to
change the characteristics of
the View.

From the View menu, click Properties.... In the View
Properties window, click the button for Projection....

19. Choose the desired
projection.

Click the Category: pull-down menu to select State Plane -
1983. Click the Type: pull-down menu to select Michigan,
Central. Click OK.

20. Change the View name Back in the View Properties window, inside the line for
Name:, erase View1 and type Michigan. Click OK.

“It’s all done!”
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ArcVoyager Special Edition Task S2
Create a choropleth map of a state

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task S1.

“I need to see if a layer contains data I can map.”
2. Select a theme, to focus
the computer’s attention on
that layer. (This is now the
“active” theme.)

In the Table of Contents, click one time directly on the name
Us_cnty.shp. The theme will look “raised” within the Table
of Contents.

3. Bring up the active theme’s
data table.

Click one time on the Open Theme Table button (looks like a
page with a series of columns and rows).

4. Explore the table. (This
table contains the information
about the features. It is
formally called a Feature
Attribute Table.)

At the bottom of the table document Attributes of
Us_cnty.shp, click on the right scroll arrow to explore all the
columns of available data.

“I need to add to the feature table some data to map.”
5. Indicate you want to add a
data table.

Click one time on the Add Table button.

“I need to find the data to add.”
6. Navigate to the proper
directory.

Navigate to the directory DATA\TABLE\US.

“I need to identify the correct type of data.”
7. Choose the proper type of
file.

In the bottom of the window, click on the List Files of Type:
pull-down menu. Choose dBASE (*.dbf).

“I need to add the correct data table.”
8. Choose the proper table. In the left-hand column file picker, double click the item

county.dbf.
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“I need to join the new data table to the existing feature table.”
9. Select the matching field in
the source table.

In the table county.dbf, click one time on the field name Fips
(the field has 5 digits). The field name will appear darkened.
Click and hold on the menu bar for this table and slide the
table off to the side, so the other windows are visible.

10. Select the window for the
target table.

Click on the Window menu and select Attributes of
Us_cnty.shp

11. Select the matching field
in the target table.

In the table Attributes of Us_cnty.shp, click one time on the
field name Fips (the field has 5 digits). The field name will
appear darkened.

12. Join the source data to the
target feature table.

Click the Join Table button (looks like two tables kissing).
The data from the source table will be appended to the
appropriate records in the target table. The source table will
disappear. Close the table Attributes of Us_cnty.shp.

“I need to edit the legend for the newly joined theme.”
13. Adjust the counties
symbol. Start by calling up
the Legend Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Us_cnty.shp. This
will bring up the Legend Editor window.

14. Adjust the counties
symbol. Continue by defining
a mapping method.

In the second pull-down menu, called Legend type, choose
Graduated color.

15. Adjust the counties
symbol. Continue by defining
the mapped theme.

In the Legend Editor window, click the pull-down menu for
Classification Field: and scroll down the list to select
Age_65_up. The computer will automatically divide the data
into five categories, with breaks where they fit best.

16. Adjust the counties
symbol. Continue by
normalizing the mapped
theme

In the pull-down menu for Normalize by:, choose Pop_1990.
This will convert an absolute number to a decimal portion.

17. Adjust the counties
symbol. Change the
classification scheme.

Click the Classify... button. In the Classification window,
change the Type: to Quantile, then change Number of
Classes: to 4. Leave the Round values at: as d.ddd. Click
OK. The computer will re-divide the data.

18. Adjust the counties
symbol. Set the color scheme.

Click on the Color Ramps: button and choose Purple
monochromatic. Then click Apply. Close the Legend Editor
window. The map will re-draw.

19. Modify the theme name in
the Table of Contents.

With Us_cnty.shp still selected (looks “elevated”) in the
Table of Contents, click on the Theme menu item and
choose Properties... to bring up the Theme Properties
window.
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20. Modify the theme name.
Specify new name. Choose to
display the field being
mapped.

In the top row, next to Theme Name:, change “Us_cnty.shp”
to just “Counties”. In the box at the top right, next to Use
Suffix, click the box to place an “x” within it. Click OK.

“It’s all done!”
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ArcVoyager Special Edition Task S3
Create a choropleth map of a state with multiple layers

To accomplish this task ... ... Do these steps using ArcVoyager Special Edition for
either Windows or Macintosh...
... or do these special steps
in Windows

... or do these special steps
in Macintosh

Set up the computer for these
directions.

(Win) Start ArcVoyager
Special Edition, assuming
data is in
C:\VOYAGER\DATA.

(Mac) Start ArcVoyager
Special Edition, assuming
data is in
HD:\VOYAGER\DATA.

“I need a base map to start with.”
1. Create a base map. Create a base map following the directions for Task S2.

“I need to get some data to map.”
2. Indicate that you want to
add a theme (a mapable layer
of geographic features).

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
3. Navigate into the directory
containing the needed data.
(You need to know where to
find the data and how to get
there.)

(Win) In the central column
of the Add Theme window,
use the directory and drive
pickers to click into the
directory DATA\GEO\US.

(Mac) In the left column of
the Add Theme window, use
the folder picker to click into
the folder DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
4. Ensure that the data type
sought is the correct format.
(ArcView can display
different kinds of data.)

In the bottom left of the Add Theme window, click and hold
on the Data Source Type and choose Feature Data Source.

“I need to choose the right pieces of data from the many available.”
5. Select the proper data
source (The correct items
here will add cities.).

(Win) In the left-hand
column, double-click the item
us_city.shp.

(Mac) In the right-hand
column, double-click the item
us_city.shp

“I need to see what the stuff I added looks like.”
6. Display the theme. (Turn
on the newly added feature.)

In the Table of Contents, click the little checkbox at the left
of the theme Us_city.shp, making a black check mark appear.
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“I need to restrict the features being displayed.”
7. Select a theme, to focus
the computer’s attention on
that layer. (This is now the
“selected” or “active” theme.)

In the Table of Contents, click one time directly on the name
Us_city.shp. The theme will look “raised” within the Table of
Contents.

8. Modify the theme
properties. Call up the theme
properties window.

From the Theme menu, choose Properties...

9. Modify the theme
properties. Make a definition.

The left column of the Theme Properties window contains
several large buttons. Highlight Definition, then click the
Query Builder button (hammer with question mark).

10. Modify the theme
properties. Construct the
definition.

In the Query Builder window, in the left-hand column
showing Fields, double click [State_name]. In the central
column, click =. Scroll down the right-hand column, find
“Michigan”, and double click it. (Using the mouse to select
items, rather than typing, helps ensure proper syntax.)

11. Modify the theme
properties. Check the
definition.

The box in the bottom of the Query Builder window should
read ([State_name] = “Michigan”). Note the presence and
positions of parentheses, brackets, and quote marks. These
need to be exact. If the statements don’t match, close the
Query Builder and return to Step9. When everything is
correct, click OK.

12. Modify the theme
properties. Apply the
definition.

Back in the Theme Properties window, click OK. The
computer will think for a second, sorting cities, and then close
the Theme Properties window. The map will redraw.

“I need to see if a layer contains data I can map.”
13. Bring up the active
theme’s data table.

Click one time on the theme Us_city.shp, then click one time
on the Table button (looks like a page with a series of
columns and rows).

14. Explore the table. (This
table contains the information
about the features. It is
formally called a Feature
Attribute Table.)

At the bottom of the table document Attributes of
Us_city.shp, click on the right scroll arrow several times to
explore all the columns of available data. Close the table
Attributes of Us_city.shp.

“I need to edit the legend for the theme.”
15. Adjust the city symbol.
Engage the Legend Editor.

In the view’s Table of Contents, double click directly on the
name itself (not on the checkbox) for the theme Us_city.shp.

16. Adjust the city symbol.
Define the map style.

In the Legend Editor window, click the pull-down menu for
Legend type: and choose Graduated symbol.

17. Adjust the city symbol.
Define the mapped theme.

In the Legend Editor window, click the pull-down menu for
Classification field: and scroll down the list to select
Pop1990. The computer will automatically divide the data into
five categories.
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18. Adjust the city symbol.
Change the classification
scheme.

Click the Classify... button. In the Classification window,
leave the Type as Natural Breaks, and Number of Classes as
5. Change Round values at to d,ddd. Click OK. The
computer will re-divide the data, into five classes, each
rounded to the nearest thousand

19. Adjust the city symbol.
Engage the symbol palette.

Near the bottom of the Legend Editor window, double-click
the colored dot symbol to bring up the symbol palette.

20. Adjust the city symbol.
Set the color.

When the symbol palette appears, click the colored paintbrush
to open the Color Palette. Select bright red. Close the
Symbol palette window. Click Apply. Close the Legend
editor window. The map will re-draw.

21. Modify the theme name in
the Table of Contents.

With Us_city.shp still selected (looks “elevated”) in the Table
of Contents, click on the Theme menu item and choose
Properties... to bring up the Theme Properties window.

22. Modify the theme name.
Specify new name. Choose to
display the field being
mapped.

In the top row, next to Theme Name:, change Us_city.shp to
just Cities. In the box at the top right, next to Use Suffix,
click the box to place an x within it. Click OK.

“I need to add more data.”
23. Indicate that you want to
add a theme.

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
24. Navigate into the folder
containing the needed data.

Navigate into the directory DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
25. Ensure that the data type
sought is the correct format.

In the bottom left of the Add Theme window, click and hold
on the Data Source Type and choose Feature Data Source.

“I need to choose the right pieces of data from the many available.”
26. Select the proper data
source (The correct items
here will add interstates.).

(Win) In the left-hand
column, double-click the item
us_route.shp.

(Mac) In the right-hand
column, double-click the item
us_route.shp

“I need to see what the stuff I added looks like.”
27. Display the map. (Turn on
the newly added feature.)

In the Table of Contents, click the checkbox at the left of the
theme Us_route.shp, making a black check mark appear.

“I need to edit the legend for the new theme.”
28. Adjust the interstates
symbol. Start by calling up
the Legend Editor.

In the Table of Contents, double click directly on the name
itself (not on the checkbox) for the theme Us_route.shp.

29. Adjust the interstates
symbol. Specify no
classification.

Click the Legend type: pull-down menu and choose Single
symbol.
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30. Adjust the interstates
symbol. Continue by calling
up the symbol palette.

Double click the colored line shown for the interstates layer
(bottom half of window, first box, left-hand column). The
Symbol Palette will appear, with the Pen Palette option
visible. Move the Pen Palette window to the side of the
Legend Editor window.

31. Adjust the interstates
symbol. Continue by
specifying the line width.

In the Pen Palette window, click Size pull-down menu and
choose 2.

32. Adjust the interstates
symbol. Continue by
specifying the color palette.

In the first row of icons in the Pen Palette window, click the
paintbrush to bring up the Color Palette.

33. Adjust the states symbol.
Continue by specifying
foreground.

In the pull-down menu beside Color:, select Foreground.

34. Adjust the states symbol.
Continue by selecting
foreground color.

In the color boxes, choose darkest red (second row, rightmost
column). Close the Color palette window. Click Apply. Close
the Legend editor window. The map will re-draw.

“I need to add a context layer to the map.”
35. Indicate that you want to
add a theme.

Click the Add Theme button (looks like a “plus” sign).

“I need to go find the data.”
36. Navigate into the folder
holding the needed data.

You should already be in the correct directory, which is
DATA\GEO\US.

“I need to make sure I’m getting the right type of data.”
37. Ensure that the data type
sought is the correct format.

In the bottom of the Add Theme window, click and hold on
the Data Source Type and choose Feature Data Source.

“I need to choose the right piece of data from the many available.”
38. Select the proper data
source. (The correct item
here will insert state
boundaries.)

(Win) In the left column,
double-click the item called
us_state.shp. The theme will
be added to the top of the
Table of Contents window
in the View.

(Mac) In the right column,
double-click the item called
us_state.shp. The theme will
be added to the top of the
Table of Contents window
in the View.

“I need to see what the stuff I added looks like.”
39. Display the theme. In the Table of Contents, click the checkbox at the left of the

theme Us_state.shp, making a black check mark appear.
“I need to change the order of the layers.”

40. Rearrange the order in
which the themes display.

In the Table of Contents, click and hold on the name States
and drag the theme down to the bottom of the list and let go.

“It’s all done!”
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